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Introduction to
Microsoft Windows

Course Objectives
U Explore the Windows desktop
U Understand the Program Manager
U Work with the File Manager
U Work with the Main group window
U Explore Windows Accessories

Your Objectives for this course:
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Overview

What is Microsoft Windows?

Microsoft Windows is a computer program that allows us to more readily use our computers. When IBM
made the first personal computer (PC) they had no idea where it would lead to. These first computers had a
very difficult operating system to understand and this made using the computer difficult. Only after the
computers had been with us for a few years did the manufacturers of both hardware (the phyiscal part of the
computer) and software (the programs we use) begin to take us, the users, seriously when we said we needed
more simplicity. 

We had to settle for all of our computer programs to be displayed by only text means, or TUI. There is of
course only so much a computer can tell us if it has only text for a display. Microsoft’s Windows program was
not the first to shift us away from the Text User Interface, however it has been one of the most popular. This
new data display standard is often times refered to as a GUI, or Graphical User Interface.

Gone is the text display. Now what we see is graphical. Everything we see in Window’s GUI is now more
visually oriented. A picture may not paint a thousand words, but it can paint at least a few hundred.

As Microsoft began to more fully develop Windows, they also attempted to overcome some of the Personal
Computer’s inefficiencies. One of the biggest problems before Windows was that a PC couldn’t run more than
one program at a time. If you wanted your spreadsheet program, and you were in your wordprocessor, you had
to exit the wordprocessor, and then start up your spreadsheet program. People often asked, “If I’ve spent
$2,000 for my computer, why can’t I run my WordPerfect and Lotus at the same time?” Most of the PC’s
“hands” were tied by it’s DOS, or Disk Operating System. Microsoft has overcome this problem and now we
can run many program simultaneously (called Multitasking) and all in a GUI. 

Another problem many people had with their earlier computers was that what they saw on the screen rarely
matched what they got when printed. Windows has fixed this problem by offering us a GUI that is more
WYSIWYG or What You See Is What You Get. 

Then many users also began to ask why so many computer programs were so different from each other. Every
time a new program was installed, it looked totally different from all the other programs. And what was
worse, all the function keys did different things causing people to have to relearn their keyboard. Microsoft is
attempting to solve this problem by offering a standard for software companies to rally around. This standard
is called CUA or Common User Access.

Multitasking, GUI, WYSIWYG and CUA are probably the biggest reasons so many people in theworld are
using Microsoft’s Windows. The Windows environment is now influencing other, non computer related
products. As Windows becomes more a part of your work life, you will probably begin to see Windows and
windows like features become more a part of your personal life and those around you.
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Starting the Windows Program

Most computers that have Windows installed usually take you right to Windows right after the computer is
turned on. If this is not case you may do one of the following:

You should be at the DOS prompt. You should see something like:

C:\>_

Type WIN and hit the [Enter] key

After a few seconds, Windows should begin.

Or,

Many computers come with a menuing system. If you have a Windows choice, go ahead and choose Windows.
If there is no Windows choice, choose go to DOS, and then use the previous described way to start Windows.

To begin this lesson, you should have the Windows program running.

About Windows

The first time you see the Windows program, what is really going on may not seem apparent at first. Looking
at Windows for the first time is like looking at those strange art works that you may see in the malls or
bookstores. You know the kind. They look like wavy or random splashes of colors and you usually see
several people staring intently at them. Suddenly, a viewer, after refocusing their eyes for a few minutes will
see a three dimensional picture. It is unnerving the first time. Windows is rather like one of the pictures.
However, instead of using your eyes, you use your Mind’s eye. The first time you look at the GUI pictures,
nothing really makes sense. But after looking at them for a few minutes, their meaning usually becomes clear.
In fact, the hardest part to understanding Windows is that it is completely active. Windows is very changeable
and often times will have many levels of programs running, or tasks available to you.

In learning about Windows, it also helps to have someone show you the program. Just think of this course as a
“let’s drive Windows around the block a few times” kind of class.

On the next page, you will see the different parts of Windows laid out. 
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The Different Named Parts of Windows

Windows Terminology

The Mouse and Pointer

Because Windows is graphical in nature, being able to navigate with the keyboard is often almost impossible.
The keyboard can still be used to obtain program’s pull-down menus (more on that later), but a different type
of pointing device has to be used. This pointing device is called a Mouse. 

Go ahead an gently rest your hand on the mouse. Most mice today fit quite comfortably in the palm. Move the
mouse around on the desk, and look to see that a corresponding arrow moves in unison. Think of that pointer
as your index finger. As you move the mouse around, the pointer will lay on top of the differernt parts of
Windows. To access the programs in Windows, you’ll use one of the buttons on the mouse. A mouse usually
comes with either or two or three buttons.  The left most mouse button is the action button.
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Typically you will place your pointer on a program and then click the left button two times, rapidly. You must
be careful to not move the mouse at all while clicking. If you move the mouse at all, nothing usually happens.
If you don’t access the program you wanted, try double clicking on it again. It takes a little practice.

Control Menu Box

When you have finished an application or program, you may want to close it so you may free up
some memory. Using your mouse pointer, move it to the Control Menu Box. You will always find
it in the upper left-hand corner of the window. You can quit the program (or close the active
window) by double clicking your left mouse button.

Control Menu Box Pulldown Menu

If you haven’t quite got the double click down, you may click once on the Control
Menu Box and get a pulldown menu. From here, if for example you wanted to close
your window, or program, you can either hit the [C] key or move your mouse cursor to
the Close choice and click on it.

Title Bar

On just about every window
there will be a Title Bar explaining or describing what application or program is running. If a window is active,
that is the one that is most on top of all the other windows, the Title Bar will dark blue (or darker than all the
other windows). This darker color clues us into the fact that it is active.

Menu Bar

In every program there will be a Menu Bar. It is located just below the Title Bar. From this bar you can access
different commands that are dependent upon the program you are in. You can pull these menus down by either
holding the [ALT] key simultaneously witht the underlined hot letter. For example, you can pull the File menu
down by holding down the [ALT] and the [F] keys. Once you have mastered using your mouse pointer, you may
want to instead use it to choose the pull-down menus. It’s easy. Just move your mouse pointer to the hot word (i.e.
File) and click on it. The File pulldown menu will appear.
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Group Icons

The Program Manager is exactly what it sounds like. It is a manager for all the Windows
programs. The Program Manager organizes these programs into pictures, or Icons. There are two
types of Icons: Group Icons, and Program Icons. Group Icons represent other groups of
applications or programs. At first they seem confusing because they are all alike, but you will
notice that each one has a text description below it that is unique. Use the text to choose the proper
group of programs you need.

Program Icons
Program Icons are your direct link to a program. Usually the picture or
icon will be very descriptive of what the program does. For example, the
calculator actualy looks like a calculator. 

Double Clicking on Icons

When you double click on a Group Icon or a Program Icon you activate the icon. In the case of the Group
Icon, you gain access to whatever Program Icons it has. You may also single click on the Group Icon and
choose Restore .  When you double click on a Program Icon, you tell Windows that you want to run the
program. If you accidently double click and begin program, don’t worry. Wait the neccessary to time for the
program to begin, and then double click on it’s Control Menu Box. You should be back to the Program
Manager.

Minimize Button

You can reduce or minimize a program or Group Icon to an icon by moving your mouse curson to this
button and clicking it once. When you minimize a Group Icon it returns back to its original size and
state. It should like a generic Group Icon with its describing text. When you minimize a program
however, something different happens. If you choose to minimize a program it will be reduced to an
icon on the Windows Desktop. The program is still running, taking up valuable computer resources
(mainly memory). At this point, you are taking advantage of Microsoft Windows’ ability to multitask. If
you want the program to be restored back to it’s original size, just move the mouse pointer back to the
mimized icon, and double click. You may single click on it, and choose Restore .

Maximize Button

You can enlarge or maximize a program or Group Icon by moving your mouse pointer to the
Maximize Button and single clicking on it. This will cause your program or Group Icon to fill the
entire screen space on your monitor. Often times you will want to maximize your program, especially
if that is your main focus. If you don’t want to be bothered with any other part of Windows, then feel
free to maximize your program. When you are first starting out in Windows, you may not want to
maximize a Group Icon. If a Group Icon is maximized, it will fill up all the available space of your
Program Manager. If you do this, you will not be able to see any other Group Icon, or Program
Icons. Don’t worry. If you maximize accidently, you may quickly return the window to it’s previous
size by single clicking on the Restore Button.
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Restore Button

If you have maximized a program or Group Icon, you may restore it quickly back to its previous size
by placing your mouse pointer on this button and clicking once. The Restore Button will usually show
up just under the Maximize Button (when you’ve maximized a Group Icon) or in place of the
Maximize Button. Remember, if you’ve maximized something, you cannot maximize it again. Hence,
the Maximize Button will be replaced with the Restore Button.

Windows Frame

If you pay careful attention to Windows, you will notice that every
window has a frame around it. You can adjust the thickness of the frame
under the Windows Control Panel. We’ll learn more about how later.
The greatest advantage to using Windows, is that you can resize and
reshape any window, just by moving your mouse pointer to the frame,

holding down the left mouse button, and dragging and dropping the pointer to a new location. It takes a little
practice at first. To resize both the height and width, most Windows users go to the lower right corner of the frame
to do the drag and dropping.

Scroll Bars

Because windows within Windows can sometimes show more information than can be seen, Microsoft adopted
Scroll Bars to help you change your view. The three main parts of the Scroll Bar are the two arrows, and the
slider button between them. If you look at this Scroll Bar you can see that the slider button is all the way to the
left. This means that the window has been scrolled all the way to the left, and cannot be scrolled to the left any
further. If you wanted to see more of the window’s right view, just move your mouse pointer to the right arrow,
and click once on it. If you hold down your mouse button, the window’s view will shift rapidly to the right.

Windows Desktop

The Window’s Desktop is that shaded or colored area behind the Program Manager. It, like the Program
Manager, never actually goes away, no matter what program you are running. In the example of the previous
page, it is a grey shade. The Desktop is changeable, and we will talk about it under the Control Panel. Often
manufacturers of PCs will ship Windows with their logo, or perhaps Microsoft’s logo. Some, like Gateway 2000
comes with a picture of a cow riding a spaceship. Microsoft Windows does have some pre-installed Desktop
screens, but again we’ll look at them later, under Control Panel.
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File Manager 

Windows’ File Manager is a picture (graphical) oriented tool to help you manage and organize your files and
directories (folders). You can access it usually under you Main Group Icon. The File Manager icon looks just
like a filing cabinet. Move your mouse pointer to the File Manager and double click on it to activate it. The File
Manager looks something like the following:

You can perform many different tasks by using the File Manager. In this section, we will cover the following:

U Changing the File Manager’s view of lists of files and folders.
U Move, copy and delete files and directories/folders.
U Format and label floppy diskettes.
U Search for files with certain names.
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Note: For the following exercises, the files listed on your PC may look different from those displayed in this
manual. Don’t worry, the exercises will still be valuable even though your machine may look different.

Using the View Pulldown Menu

Move your mouse pointer to the View menu choice (on the File Manager’s menu bar) and single click. You
should see the following:

Now is a good time to explain what files and directories/folders are. A file is an
electronic document or an application or program that has been named and filed
(stored) on you computer’s hard or floppy disk. A file could be a memo you wrote to
your boss, or the word-processing application that created the memo. The nice thing
about all this is that files have unique names. When you create a file, you must give it a
unique name. When programs (applications) are installed on your computer, they are
usually named by the company who sold you the software. You may file your files (or
programs) in directories. The directories look like little yellow manila folders. Hence,
that is why directories are now often called folders.

Unfortunately, your computer does not usually force you to file your documents in
folders, so you must learn and practice good filing techniques. For example, unless you
understand how to store your files in folders, your computer would allow you to place
all your files in one folder. Imagine if you did that back at the office. Imagine all your
correspondence, reports, spreadsheets, etc. stuffed into one gigantic manila folder!
You probably wouldn’t be able to find any thing after a few months. Even though your
files must be given unique names, that still is not enough to file your folders properly
for easier retrieval later.

Changing the Sorted Order of Your Files

In the View pulldown menu, notice that there are many different choices of how and what to change. The View
refers to the way the files and directories are “viewed” in the File Manager. What changes you make here, will
affect the File Manager from now on. 

In my example, notice that there is a check mark in front of Date. This means that my files are listed in
chronological order with the newest on top of the list. Directories (folders) are not affected by this choice. 

TSort by Date

If there is no check mark in front of the Sort by Date, move your mouse pointer to it and click once. Your files
will now be in chronologic order.

TSort by Name

Move your mouse pointer to Sort by Name  and click on it. Suddenly all the files are now listed in alphabetized
order (from A to Z).

TSort by Size
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Occasionally it is nice to be able to sort on the sizes of the files. Typically you might use this to see which files
are taking up the most room on your hard or floppy disk. Sometimes you may need to delete files to open up more
room on your disk, and the ones that are taking up the most room might be the first to go. We’ll see later how to
delete files.

Formatting a Floppy Disk

In the past, when we purchased new floppy disks we had to prepare or format them for our PC. Since the
manufacturers made diskettes for many types of computers, formatting them was necessary. In the last year or so,
though, our type of personal computer (IBM PC) has become one of the most popular, and so many manufacturers
have begun to sell pre-formated disks. Purchasing pre-formatted disks does save you some time, but in the end,
formatting a disk takes only minutes, and the unformatted disks are cheaper.

Note: When you format a disk, if there was any information (files, programs, etc.) previously on it, that
information will now be completely erased. You typically only format a new disk, or a disk where you
don’t care what’s on it. Also, never attempt to format your hard or network drives. Generally format
should only be used for floppy disks.

For this exercise, insert the blank floppy that your instructor has given you into the floppy disk drive. 

Hold on to your floppy with the label side up, with the metal tab away from you. Refer to the picture to the left if
you need to. Gently insert the disk into the slot. Push gently until the disk locks into place. 

Now, move your mouse pointer to the Disk menu choice and click on it. You should see
the following pull down choices:

Notice that there are three periods (...) after the choice. This means that Windows will
bring up a box called a Dialog Box where you may make specific choices that are

related to formatting disks.

Note: Not all floppy disks are alike. You probably have (and need) disks that say HD
or High Density on the metal tab or disk label. These diskettes can store approximately
1,400,000 bytes of information. The older floppy disks, usually designated as DD or
Double Density on the metal tab or disk label can only store half as much information
(approximately 720,000 bytes). 

Choose Format Disk...

You should now see the following Dialog Box:
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Drive Letter Designation

A: Primary Floppy Disk Drive

B: Secondary Floppy Disk Drive

C: Primary Internal Hard Disk Drive

D: Secondary Internal Hard Disk Drive

E: Typically a CD-ROM Drive

F: to Z: Typically a Network Drive

Notice that the Dialog Box defaults to certain choices. For
example the Disk In: choice is Drive A: What this means
is that you are about to format the disk you just inserted
into the disk drive.

That is the primary floppy disk drive, or A:
drive. All drives on your computer are
designated by drive letters. The disk drive
letter will always be a single letter followed
by a colon. 

The following table describes possible drive
letter designations. There is never a drive
with more than one letter. The colon is added,
to help you distinguish between the letter
(which could be a file name, though not a
good one) and a disk drive.

Before your format the floppy disk in the A:
drive, move your mouse pointer to the empty
box next to Label: and click once on the box.
You should see a slim cursor appear within

the box. Go ahead and type your name. Then move your mouse pointer to the OK button and click once on it. This
will begin the formatting process. When the disk has been completely formatted, it will be ready for you to use. It
will even have an internal label with your name on it. This is a great tool to help identify your disks at the office.
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Changing to another Disk Drive

Focus your attention on the bar just below the Menu Bar. It will look something like this:

This shows what disk drives Windows knows you have. In this example, there are four disk drives. A: B: C: and
D: Disk drive A: and B: are floppy disk drives, whereas C: is an internal hard drive, and D: is a CD-ROM drive.
To change to another disk drive is very simple. Right now the C: drive is the highlighted drive. It is called the
active drive. All my folders and files listed in the File Manager are those on the C: drive. 

Move your mouse pointer to the picture (icon) of the A: drive and click once on it. 

Notice suddenly that the listing of files is now that of the A: drive. There should be no files found. Remember, we
just formatted the disk (destroying any information on it).

Move your mouse pointer to the picture of the C: drive and click once on it. Suddenly we are back on the C: drive
and all of it’s folders and files are available.

Creating an Empty Directory/Folder

Let’s do this work on the A: drive for today, that way we’ll not harm or change information on the C: drive.

Move your mouse pointer to the A: drive icon and click on it once. You should now be on your blank A: disk.

Your screen should look like the following:

Notice that there is one directory/folder on the A: drive. It is called the Root or Main Directory/Folder and is
designated by the “\” called a back-slash. In fact notice carefully that the a:\ folder is open. In the File Manager
you can always tell what directory/folder is open becuase the picture shows an open folder. 
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Now, move your mouse pointer to the File pulldown menu, and click once on it to bring down the file choices.
You see something like the following pulldown menu:

As you can see there are many choices under the File pulldown menu. From
here you can do many important file managing things like copy, delete,
undelete (maybe), rename, run, create an empty directory, and even search
for files seemingly buried in your folders or disks.

In this manual, we will explore a few of these menu choices. For now, let’s
focus on the Create Directory... menu choice.

When you choose Create Directory, the File Manager will create an empty
directory/folder on whatever you had chosen for your active disk drive. In
this case it is the A: drive.

Move your mouse pointer to the Create Directory... choice and click on it.
You should see a Dialog Box pop up like the following:

Go ahead and type MEMOS.

Move your mouse pointer to the OK button and
click once on it. 

You should now see a new, blank directory/folder
on the A: disk. 

To make it the active (open) folder, just move your mouse pointer to the MEMOS folder and click on it. Do see
that it is now open? Remember, there are no files or folders within the MEMOS folder. 

Now that the MEMOS folder is created and open, click on the File pulldown menu and choose Create
Directory. Type in 1995. Click on 1995 and open the folder. Now create two folders called JANUARY and
FEBRUARY.  This is a good example on how you might keep your memos organized on your floppy disk. 

DOS File and Directory/Folder Naming Conventions

All names on our PC today are governed currently by what is called the 8.3 rule. This means that are file names
cannot exceed eight (8) consecutive letters or numbers. But, we can add a period on to the file name and then add
three (3) more letters or numbers. Remember you cannot have a colon in your file name. Here are some examples
of valid file names:

MEMO1201 395BOB.LET REPORT96.WPD 5589.XLS A.A
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Here are some examples of invalid names. Look them over and think about why they are invalid.

ANONYMOUS.LET SILLY.PUTTY A:89.95

Copying Files to another Disk Drive

There are two ways to copy a file to another disk drive. One way is using the File pulldown menu, and choosing
Copy... and the other way is not so obvious, called the Drag and Drop Copy.

Let’s try the pulldown menu first. 

Move your mouse pointer to the C: drive icon and single click on it. You should be on the C: drive now. Make
sure you’re in the Windows folder. Make sure that your view of the files is in name (alphabetical) order. 

Selecting a File from the View

Move your mouse pointer over to a file like ACCESSOR.GRP and single click on the file.

Note: Be very careful! Don’t double click on a file. If you double click on a file, Windows thinks you’re trying
to lauch it as a program. This file is not a program, and if double clicked on, will give you an error.

Now, move your mouse pointer to the File pulldown menu and click on it. Choose Copy... You should see the
following dialog box popup:

Now type the following in the To: box

A:ACCESSOR.GRP

Move your mouse pointer to the OK button,
and click once on it. Watch the disk drive light on your A: drive light up. The file is being copied to the disk.
When it is done, you will have an exact duplicate of your file on that floppy disk.

Note: Never attempt to remove the disk from the A: drive while the disk activity light is on. Always wait until it
is done with your disk before removing it.

Move your mouse pointer to the A: drive icon and single click on it. You should now be on the A: drive. Check to
see if the copied file is there. It’s always a good idea to check to see if your copy is there, especially before
handing the disk to another worker (or boss).
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Using the Drag and Drop Method to Copy a File

Windows is often times very visual (or GUI) in some of its approaches of doing things. For example, you can
easily copy a file by dragging and dropping the file on to the A: drive icon. A drag and drop is where you go to
the object you want to drag and drop, hold down your left mouse button while on the object, and while holding
down the left mouse button, you move the mouse pointer to where you want to drop the object, and then let go of
the mouse button. Where ever the mouse pointer was pointing when you let go of the mouse button, that is where
your object (in this case a file) will be dropped.

Let’s go ahead and try it.

Make sure you are on the C: drive and the open folder is the Windows directory. Make sure that the
ACCESSOR.GRP file is highlighted (single click on it to select it). 

Move your mouse pointer to the file. Now carefully hold down your left mouse button while on the file. Continue
to hold the mouse button down. Now gently drag the mouse pointer (notice the pointer has changed) to the A:
drive icon. Once you have the reached the picture of the A: drive, let the mouse button go. You should see a
window like the following pop up.

Windows is verifying that it’s okay to copy this file to the A: drive (specifically the MEMOS\1995\FEBRUARY
folder). Move your mouse pointer to the Yes button and click on it once. Another small window will pop up for a
moment telling you that the file is being copied. Because you had already copied this file to the A: drive, you
should have gotten a message like the following:

Windows is warning you that you
already have a file by that name on the
A: drive. Sometimes it’s a good idea to
be warned about such a situation, just
in case you really don’t want to
overwrite the other file. To help you
make your decision, the file size, date
and time are included so you may
compare them. In this case, we know
that the files are exactly the same.
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Moving a File to Another Disk Drive

Moving a file, like copying a file, can be done two ways. There is the File pulldown method, and there is the
Drap and Drop method. We will only do the Drag and Drop method.

Moving a file with the Drag and Drop method is almost exactly the same as the copy method, except that we have
to hold down the [SHIFT] key on our keyboard while we perform the drag and drop. Let’s try it.

For this exercise we need to be on the A: drive. Make sure you’re on the A: drive, and in the February
directory/folder. You should see your copy of the ACCESSOR.GRP file there. Say that we had made a mistake
in placing the file in the February folder and had actually wanted it in the January folder. Let’s move the file to the
January folder.

First move your mouse pointer to the file and single click on it to select it. Now, place your mouse pointer
somewhere on the file. Hold down the [SHIFT] key. Now click and hold down the left mouse button. Drag the file
over to the January folder and drop it on the folder. Now let go of the [SHIFT] key. You should see the following
window pop up.

Windows is allowing you the
chance to decide otherwise.
If you didn’t want to move
the file to the January folder,
you could back out now. We
do want to, so click on the
Yes button. The moving will
take place quickly.

To make sure you really did move the file, single click on the January folder and see what’s inside it.

File Search 

No matter how good a job we do at organizing our files, months down the road we may forget where we placed a
file. Especially when we “inherit” a computer from someone else or when someone is out sick and you need a file
on one of their disks, being able to search for the file comes in very handy. Windows File Manager has a built in
file search to help us out. 

Let’s search for the same file that we’ve been copying on the C: drive. Make sure you are on the C: drive. Then to
make it more interesting, let’s click on the main directory/folder of the C: drive. It’s at the top of the scrollable
list of folders on the C: drive. It should like this:

The C:\ folder should be open. This is how we know we are at the beginning of the
folders. Often times we don’t know where a file could be stored, so it’s always a good
idea to start off in the main C:\ folder.

Move your mouse pointer to the File pulldown menu and click on it. Choose the Search...
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dialog choice. You should see the Search dialog box pop up.

Notice that in the Search For:
box there is a highlighted *.*?
This is where we get to type in
the file name. Let’s say though
that we only remember that the
file started with the letters ACC.
The search window allows us to
be a little less than exact. 

Because we only know the file name begins with the letters ACC we can type ACC*.* in the box. Adding the *.*
to the end tells Windows that we want all the files that begin with the letters ACC and end with any other
combination of letters or numbers. By adding the .* we also tell Windows that we want all the files that have any
three (3) letter or number file extension (the information after the period). 

Since we don’t know exactly where the file is on the hard drive (I know, we actually do in this case) we will

leave the : on in front of the Search All Subdirectories. This means that all directories/folders will be searched
within the main folder C:\ (in this case, the entire hard drive will be searched). 

Click on the OK button. When the search is done, you may get something like the following:

In this case, the search has turned up eight (8) files on my C: drive that match my search criteria. In this case, most
of the files happen to be in
a folder callde
ORGANIZE. As you can
see though, the search did
find the file we were
looking for
ACCESSOR.GRP.
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Appendix A: The Main Icon Group

This section contains brief overviews of select program icons in the Main Icon Group.

U Control Panel
U MS-DOS Prompt
U Clipboard (or ClipBook Viewer)

Control Panel

The Control Panel
provides you with a visual way of modifying your system while working with Windows. Each option is
represented by an icon in the Control Panel window. 

These options include: 

U Your screen colors. 
U Other desktop options that determine the look of Windows for Workgroups. 
U The fonts recognized by your Windows-based applications. 
U The printer you use. 
U Keyboard and pointing-device settings. 
U Fax modem settings. 
U International settings. 
U Port settings. 
U Network settings. 
U The system date and time. 
U The sounds your system uses. 
U MIDI settings for a synthesizer connected to your computer. 
U Multitasking settings for running Windows for Workgroups. 

When you change an option, it is stored internally so that it will be in effect the next time you run Windows. Some
changes may go into affect, like screen colors or screen saver (under the Desktop icon).
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MS-DOS Prompt

Double clicking on this icon will take your temporarily out of Windows and into MS-DOS (Microsoft’s Disk
Operating System). Typically you will only be using this application to run DOS based software that you don’t
have access to under the normal Windows icons.

When you are running DOS from here, Windows is still running. When you are done using the DOS prompt, you
should type EXIT to exit back to Windows. Be careful though, many DOS based programs can conflict with
Windows and can “lock up” your computer. If this happens, you will need to reboot (or reset) your PC. If your
computer takes you immediately back to Windows, and you still need to run the program, then exit Windows. This
should put you at the normal MS-DOS prompt.

Note: If you have accessed the DOS prompt from Windows, never turn off your computer while you are in it.
Windows is still running, and turning off your computer while in Windows can cause serious hard drive
problems. Always exit Windows properly (click on File pulldown menu, choose Exit Windows...

Clipboard/Clipbook Viewer

What Is ClipBook Viewer?

The ClipBook Viewer window contains two smaller windows: the Local ClipBook and the Clipboard. The Local
ClipBook window opens when you first start ClipBook Viewer. The Clipboard window appears as an icon. 
The Clipboard temporarily stores information you are transferring between documents, and the Local ClipBook
permanently stores information you want to save and share with other people. 

The Clipboard window shows the current contents of the Clipboard. When you cut or copy information from an
application, it is placed onto the Clipboard and remains there until you clear the Clipboard or until you cut or
copy another piece of information.

You can paste the information into any document(s) as often as you like. You can permanently save the current
contents of the Clipboard by copying it onto your Local ClipBook. You can save several pieces of information
(called pages) on it, and then copy the information back onto the Clipboard when you want to paste it into a
document. After information is saved as a page, you can share it. Each computer has its own Local ClipBook. You
can connect to a ClipBook on another computer, and others can connect to the Local ClipBook on your computer
to use the information in shared pages. 
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Appendix B: Accessories Icon Group

This section contains brief overviews of the following programs under the Accessories Icon Group:

U Paintbrush
U Write
U Calculator
U Clock
U Notepad

Paintbrush

W
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indows’ Paintbrush is a simple and straight forward drawing program that allows you to work in black and white
or in color. Once you’ve drawn your picture, you may save, print or include it in most other Windows software
programs (like a wordprocessing package).

Here is a description of the different tools available:

  Tool What it does

Scissors Defines an area to cut, copy, or change.
Pick Tool Defines a rectangular are to cut, copy, or change.
Airbrush Creates a cricular spray of dots.
Text tool Adds text to your drawing.
Color Eraser Changes colors in all or part of your drawing.
eraser Changes foreground colors to the the selected background color.
Paint Roller Fills any closed shape or are with color.
Brush Draws freehand shapes and lines.
Cruve Draws curved lines.
Line Draws staight lines.
Box Draws hollow squares and rectangles.
Filled Box Draws squares and rectangles filled with color.
Rounded Box Draws hollow round-cornered squares and rectangles.
Filled Rounded Box Draws round-cornered squares and rectangles filled with color.
Circle/Ellipse Draws hollow circles and ellipses.
Filled Circle/Ellipse Draws circles and ellipses filled with color.
Polygon Draws polygons (irregular shapes) from connected straight lines.
Filled Polygon Draws polygons filled with color.

To learn more about Paintbrush, click on the Help on the Paintbrush menu bar.



1-22 Introduction to Microsoft Windows

© 1995 Scott Humphries

Write

The Windows Write program is actually a good word processor. It can do many things that other word
processors can do, such as: 

U Change fonts
U Cut, copy and paste text
U Adjust line spacing
U Adjust margins
U Add headers and footers
U Change tab settings
U Accept paint brush pictures

On many PC’s today, if Microsoft’s Windows is the only program installed, you can use Write to produce letters,
reports or even newsletters. You only need to purchase another word if Write doesn’t have enough features. Most
other Windows’ based wordprocessors are completely compatible with Write.

To learn more about the Write, click on the Help on the Write menu bar.
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Calculator

The Windows
Calculator includes both a standard and scientific calculator. Most poeple use the standard calculator to do
simple calculations and then store them in memor. Typically, most use the scientific calculator to do more
advanced scientific or statistical calculations.

To learn more about the Calculator, click on Help on the Calculator menu bar.

Clock

Here is an example of the Clock program can look like. You can add or change the
display depending on what you like. 

Clicking on Settings will give you direct access to the many different ways to change the display of the clock.
Under Settings you can change:

U Display to analog or digital.
U Change the font (type face) on the clock.
U Leave or take away the title (Clock).
U Add or take away the display of seconds.
U Add or take away the date.
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Notepad

At first glance, you might think that Notepad is a wordprocessor but it
really isn’t. 

Notepad should be used to edit text files. Text files are those files that are
ASCII text, such as your AUTOEXEC.BAT or CONFIG.SYS files. Many
PC files that have special information on computer settings are stored as
ASCII text. 

You can use Notepad as a very basic wordprocessor, but you will find that Windows’ Write is much better for
that. When you save files in Notepad, they are stored automatically as ASCII text. 


